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1 General Information

The firmware can be installed on UPV or UPV66. This firmware revision consists of two files:
Setup_230409Release.msi
UPVCheckPreconditions_1_1.exe

It is recommended to copy the file “Setup_230409Release.msi” to the folder
“‘D:\R&S_ Software\Firmware” and the file “UPVCheckPreconditions_1_1.exe” to the folder
“D:\R&S_Software\Miscellaneous” on the UPV'’s hard disk.

The file “UPVCheckPreconditions_1_1.exe” is only needed if the screen resolution of a UPV66
shall be set to a resolution higher than 800x600 (for details see below: New Features)

2 Firmware Upgrade

For any upgrade from a version 1.x to a version higher than 2.0.0 the upgrade to version
2.0.0 is required before. For this purpose a bootable CD “UPV Audio Analyzer Firmware
Upgrade 2.0.0” is provided, which is included in the “UPV Firmware Version 2.0.0
Installation Manual”, ident number 1406.0154.42.

Please contact your local R&S agency to receive the Installation Manual and the CD-ROM
free of charge.

Switch on UPV, connect mouse to UPV, close UPV application

Install UPV firmware by running the file Setup_230409Release.msi in the folder
D:\R&S_ Software\Firmware

Follow the instructions on screen
The instrument reboots automatically.

During reboot — when the BIOS starts as shown in the figure below — switch UPV off and on again.
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3 New Features

Version 2.3.0

Analyzer/Generator

UPV-B48 option “Eight-Channel Analog Inputs” supported

RMS selective: Minimum filter bandwidth was reduced to 10 Hz for analog analyzer with 22 kHz
bandwidth and digital analyzer with sampling frequencies below 48 kHz.

Several improvements with Delay measurement and Gen Burst setting: better handling of
missing signals (digital) and overall performance

Digital Analyzer/Generator: If any level is set using the units Bits or LSBs, then this level is no

longer affected by the change of Audio Bits. Especially usefull for dither.

New analog or digital generator signal “Square”, generated as a

Multi sine signal (“analog or digital: frequency domain”),
with good frequency resolution, bad time domain shape.
Frequency range fsample/4800 to fsample/10

orasa

Pre calculated ARB data set (“digital: time domain”),
with bad frequency resolution, good time domain shape.
Frequency range fsample/262144 to fsample/2

or

Using the UPV-B3 analog square generator (“analog: time domain”),
with good frequency resolution, good time domain shape (f3dB = 100 kHz).
Frequency range 187.5 Hz to 80 kHz

PESQ measurement now supports P862.1 silence / speech and P862.2 silence / speech.
Dropouts may be displayed additionally to ref and deg signal form.

PESQ measurement now allows storing the degraded data as WAV file

PESQ measurements up to 1000s signal length possible

Dropping the high pass filter inside the ADC if at least one channel is selected as “DC coupling”

Preemphasis/Deemphasis 50 and 75 filters: Frequency response improved for bandwidths 22
kHz and 40 kHz (analog analyzer) and sample rates below 192 kHz (digital analyzer).

Analog analyzer: If Channel is set to 1 & 2, AC/DC coupling can now be independently selected
for each channel.

Remote Control

Remote control commands implemented for

Sweep Graphd Conlig

DISPlay:SWEep<i>:SMODe SINGlescan | MULTiscan
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DISPlay:SWEep<i>:HISTory <n>
DISPlay:SWEep<i>:MINMax ON | OFF

SCPI update is now set to OFF after every start-up of the UPV application.

Remote control: Up to now the return value of SENSe[1]:VOLTage:RANGe<i>:VALue? was the
voltage range, which could be measured without under or over range. From now on the return
value is the nominal value of the range in volt (compliant to UPL).

Example:

Fange IFix j

|1 50.0mY RMS j

Old return value: <0.11 ... 0.19799V>

New return value: 0.18

Remote Control: An executable *.exe can now be called with a list of parameters (up to now no
parametrs possible). Example: SYST:PROG:EXEC 'progname.exe arg1 arg2 ... ".

Filename may include spaces.

Remote Control: All TRACE: and Display: commands defined for sweep subsystem are now
available for PESQ subsystem, too.

Graphics

Color Profiles: Colors and linestyles in the UPV graphics windows can be defined for:
Background, Frame, Grid, Traces/Scans, Limit Check and Cursors.

The definition can be done independently for graphics output to:

Colour Profiles

Screen fizcreen opf
Prirfer sprirder opf
File igretidile gof s
Clipboard Hpboard gpf | ..

by the use of graphic profile files, which are loaded in Menu - Utilities - Config Panel.

IR

Utiities Windows Help
I Disgnostic Panel (closed)
Config Panel
Quick Launch Config...

opens the grafic profile preview/editor for the active graphics window.

A print preview can be opened in the file menu.

Config Panels for Function, Level Monitor and Input:

All settings made for channel 1 can now be copied to channel 2
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Funection Config

General

Up to now the screen resolution of a UPV66 was fixed to 800x600. The file
“UPVCheckPreconditions_1_1.exe” enables the UPV66, that a resolution higher than 800x600
can be set: Copy the file to the UPV66 and start it. Follow the instructions on screen. Afterwards
the screen resolution can be changed in the same way as for the UPV model 02.

German Help Language now supported

Quick launch toolbar now supporting coloured icons: green = active screen / yellow = inactive
with panels visible / grey = inactive and empty

Trigger Output: “Mode = Measuring” now implemented: Depending on Edge = Rising/Falling the
output signal is High/Low while a measurement is performed (DSP-time + delays + post-
processing)

Audio Monitor: Signal source = Function: Upper limit of volume control range is increased from 0
dB to +120 dB. Now very small signals far below full scale range can now be amplified beyond
the hearing threshold.

Audio Monitor: Signal source = Function: Volume is no longer reduced when a filter is cut in.

Trace state "Hold" / "Alive" will now be reset to "Alive" automatically in following cases: start of
firmware / PRESET / loading setup / changing the source away from "OFF" or "File".

Version 2.1.1

No new features compared to version 2.1.0.260

The list of remote commands “UPV_Remote_Commands_V210260.pdf” is still valid

Version 2.1.0

Analyzer/Generator

Speech quality measurement PESQ according to ITU-T recommendation P.862 is now available
with software option UPV-K61.
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Analyzer Function M =] B3

Function IF'ESQ j [

According to I PESG P.BEZ j

hess Maode
PESG zilence
Record Length PESG: speach
Ref Level WOS PEE2.1
MOE PEE2.2

Deg Level

A Delay I 0.0aoon ms

The Numeric Display shows the MOS value. The average delay is displayed in the analyzer
function panel. A new display panel PESQ Graph is available showing MOS and delay versus
time.

PESQ is a single channel measurement available in analog domain only. Analog analyzer must
be set to Channel 1 or 2 and to a fixed level range. Analog generator function Play is used to
provide the reference signal for the device under test.

Analyzer function FFT provides new feature "Undersample FFT". FFT resolution is improved
while reducing the measurement bandwidth. The maximum undersampling factor is 1024
(selectable steps are 2, 4, 8, 16, ...). Option UPV-KG® is required to activate this feature.

Undersample  [»
Span | 1.50 kHz :J

Remote control commands:
SENSe[1]:FUNCtion:FFT:USAMple ON|OFF
SENSe[1]:FUNCtion:FFT:CMPFactor <n>

To get the best undersample FFT resolution, it is recommended to use the lowest analog
analyzer bandwidth and the longest FFT size before invoking the undersample FFT feature. For
analog analyzer 22 kHz, using an FFT size of 256 k, the highest undersample FFT resolution is
0.18 mHz in a bandwidth from 0 Hz to 23 Hz.

To measure those very low frequency signals the analog analyzer must be set to DC coupling
and to a fixed level range.

Not available for 250 kHz bandwidth analog analyzer.

Maximum sample rate for digital analyzers is limited by the number of filters used. Sample rates
up to 96 kHz are fully supported without any restrictions.

The results for Input Peak, RMS, Frequency and Phase are calculated simultaneously.

When "Undersample FFT" is used, Waveform function is switched on with the settings:
Meas Mode: Undersampling
Trigger Source: Manual
Compression factor: according to FFT undersampling factor

Generator minimum sine wave frequency is reduced to 10 mHz (up to now 100 mHz)
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Option UPV-KE6 is required to activate this feature.

C weighting filter available for analyzer and generator.

Remote control commands:
Pre-Filter "INPut:FILTer CWE"
Function Filter "SENSe[1]:FILTer CWE"
Generator Filter "SOURce:FILTer CWE"

THD+N and SINAD measurement:

Level measurement of fundamental frequency has changed:
Up to now: Level of fundamental frequency was measured after the function filter(s)
From now on: Level of fundamental frequency is measured before the function filter(s)
Without pre-filter this reading is compatible to UPD/UPL.

Level of THD+N signal is measured after the function filter(s)

Pre-filter is always applied to both fundamental and THD+N level measurement.

Generator Signal DIM available in digital domain, too.

Graphics

Multi-scan is switched on in the sweep config panel if a z-sweep is used in the generator.

Remote Control

When a continuous sweep was started, up to now OPC was not generated, because a
continuous sweep never terminates. Now OPC is generated when the sweep reaches the stop
value for the first time.

If a z-sweep is active, OPC is sent when the z-sweep terminates.

(now compatible to UPL)

Version 2.0.1

UPV66 is supported with this version

No changes for UPV compared to version 2.0.0.226

The list of remote commands “UPV_Remote_Commands_V200226.pdf” is still valid

Version 2.0.0

Analyzer/Generator

Peak and Quasi-Peak measurement: Minimum Interval time was reduced from 20 ms to 1 ms

Analyzer function DIM measurement available in digital domain, too.

Analyzer function DIM measurement in analog domain now possible without option UPV-B3
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installed.

New DIM signal and (automatic) DIM measurement mode: 2.96 kHz square with 8 kHz sine.
Remote control command for generator: “SOURce:DIM DIMS”

New Waveform Trigger Source Gen Burst.

Using this trigger mode, together with a sine burst generator signal, Delay Measurement is now
possible for analog-digital, digital-analog, digital-digital and analog-analog devices under test.

The start of the generator burst starts the waveform recording. In the waveform display, the time
between zero and the start of the burst is the delay of the device under test.

This measurement is not possible, when:
- Low distortion generator is switched on
- Analog analyzer bandwidth is set to 250 kHz
Remote control command “SENSe7:TRIGger:SOURce GENBurst”

Additional Highpass and Lowpass Filters implemented

HighPaszs 22 Hz -3dB @ 22.4 Hz (3rd order Butterworth)
|HighPa=ss 400 Hz -3 dB @ 400 Hz (3™ order Butterworth)
LowPazs 22 kHz -3dB @ 22.4 kHz (4th order Butterworth)
|LowwPass 30 kHz -3dB @ 30 kHz (3rd order Butterworth)
|LowwPass 80 kHz -3dB @ 80 kHz (3rd order Butterworth)
AESAT - +/- 0.1 dB to 20 kHz, < - 60 dB from 24 kHz, compliant to AES17

Analyzer Start Condition Delay was extended to 5 s (limited to 2 s up to now). If delay is longer
than 2 seconds, after any change in instrument settings, measurement does not automatically
restart, but has to be restarted via Start or Single key.

Remote Control

New remote control command "INITiate:CONTinuous WAIT"

When reading results in the mode "init:cont on" the UPV didn't block the bus until a new result
was available but returned the old one.

This new command works like "init cont on", but now the bus is blocked until a new result is
available.

To avoid a "forever" blocking time, a command for defining a timeout was added:
"INITiate:CONTinuous:TIMeout <nu>", where <nu> is in the range of Os to 1000s.

When the defined time out is elapsed without having a new result, the UPV will return the
previous one. If <nu> is set to Os, "init:cont wait" is identical to "init:cont on".

Remote control commands to read back the error flags, which are generated by digital audio
protocol analysis:

SENSe8:PROTocol:ERRor?
Returns the state of all error flags

0,"No error"
or
<n>"PCM1,PCM2,PAR1,PAR2,..."

<n>is a 10 Bit Integer (decimal value range is 0 to 1023),
errors are indicated by bits dO to d9:
0 indicates no error
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Version 2.3.0

Return value is
"0" = no error
or

"1" = error

PCM1
PCM2

PAR1
PAR2

LOC1
LOC2

CRCA1
CRC2

INV1
INV2

The string "PCM1,PCM2,PAR1,PAR2,

<j>=1 or 2 for Channel 1 or 2

1 indicates error
do:
d1:

d2:
d3:

d4:
ds:

d6:
d7:

ds:
do:

not PCM coded

Parity error

Lock error

CRC error

Validity error

The following commands can be used to query a particular error flag:
SENSe8:PROTocol:ERRor:PCM<i>?
SENSe8:PROTocol:ERRor:PAR<i>?
SENSe8:PROTocol:ERRor:LOC<i>?
SENSe8:PROTocol:ERRor:CRC<i>?
SENSe8:PROTocol:ERRor:INV<i>?

..." only contains flags indicating an error

Remote control commands for Normalize:
DISPlay:Subsys<i>:A|B:NORMalize OFF | VALue | OCURsor | XCURsor
DISPlay:Subsys<i>:A|B:NORMalize:VALue <nu>
Subsys = SWEep | BARgraph | FFT

Graphics

Monitor Config.

Digital Analyzer: Maximum range of level reference value was increased from 40 dBFS to 80
dBFS for Function Config (different values for both channels possible), Input Config and Level

New Y-Source “FFT Phase Ch2 — Ch1” selectable for FFT Graph Displays: Shows the Phase
difference between FFT spectra of Channel 1 and 2.

General

New file format *.SAC to store/load the instrument state. If this file extension (instead of *.SET)
is used, only the hardware settings of the instrument are stored, the panel settings are not
stored. When loading such a file, just the hardware settings are restored, the actual panel
settings keep unchanged. This new feature can be used to load the same hardware settings into
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different configurations of the user interface.

Quick Launch Buttons

s -]

The new Quick Launch Buttons ' are integrated in the UPV Toolbar...

M Rohde & Schwarz Audio Analyzer UPY Screen 2

File Edit Scresns Instruments DispConfig Displays Sequence Ltiities Windows Help

P> @R DEEIEBE-ssu--n-|

... just with one mouse click you can load an instrument setup or start an executable macro file.

Setups are marked with S
wnce  LEiities Windows Help

i
(5] ~SEM- M-

[o:puevjuserjne_widez set|

Macros are marked with M
lence  Ltifities Windows Help
[5] ~SSM-~M-|

W
['-:!.I'Prﬂ.'.l*ﬂ'ﬂ FilesRohdefSchwearz/UPY-K9:x Mobde Phone Tests,l‘Phar-eTest.e*xel

If you click on an empty (--) quick launch button, a browser window opens, where you can select
a setup file (*.set) or an executable macro file (*.exe)

Use the Quick Launch Configure Panel for further configuration

ience  Ltitis Windows Help
m Disgrcestic Panel (dosed)
=== Corfig Panel {dosed)

... opens the Quick Launch Configure Panel ...

W Configure Quick Launch 2
mere) best [evecubs on LOCAL key if checked) command
) [
i3 _lli meszage fber frequency response [u:l UPY/STR_Setupsldnalog/omessresp. set
I II:I AUPY Mser/ne_vade2 set

|%chwaraﬂ.lF"v‘-KEIx Mobie Phone Tests/PhoneTest exe

ID SRES_SoltwareUPY-E Su/S etup Exe
N |

oK Cancel |

Ll befe fe e e |

nE R R m

You can edit and delete menu text and command
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If the command is deleted the button becomes empty again

If a command line is checked, it will be executed when the front panel LOCAL key is pressed.

Improvements when operating the UPV with external keyboard and mouse:

1. Numeric entry fields now accept unit abbreviations on the external keyboard

norN nVv

uorU us, BV, yW
m or M ms, mV, mW
k or K kHz, kV

hor H Hz

vorV V

worW W

sorS s

2. After you have made a numeric entry, without pressing the Enter key, and then click on
another field, the just-entered value is taken as entry (up to now the just-entered new
value was rejected and the old one was still valid).

Version 1.4.0

Analyzer/Generator

Digital Audio Analyzer and IIS Analyzer: Automatic detection of input sample rate implemented

Digital Audio Analyzer: Sample rate can be set according to channel status data

Preemphasis filters now available:

Preemph 5015
Preemph 20
Preemph 75

All functions of External Sweep now implemented (up to now only Auto, Time Chart and Time
Tick available), via Start Conditions:

Freg Chi

Freg Ch2
Freq Fast Chi
Freq Fast Ch2
Yolt Chi

Yolt Ch

Lev Trig Chi
Lev Trig Ch?
Edge Trig Chi
Edge Trig Ch2

Time Tick: Time ticks are ignored, if they occur while the measurement has not yet terminated.

Analyzer function RMS selective: Sweep Control = Auto List now implemented

Generator Function “Play + Analyzer”: The input signal of the analyzer is routed internally to the
generator. A *.wav file can be added (this function is intended to be used for mobile phone
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measurements).

Amplitude Variation implemented for generator functions Multisine, Arbitrary, Random and Play
(this feature is intended to be used for mobile phone measurements).

New Generator Output Type “Com Mode Test” to provide a common mode test signal. Same
Signal at pins 2 and 3 of XLR connector.

Generator Config M [=

Instrument |Anu||:|g ri -
Channed 2=1 -
Outputt Type |L:-:un Mode Test =
Impedance Uiribal

Bal
Comnen (RPN

Remote control command: OUTPut:TYPE CTESt

New Generator Instrument: “Digital Impairment”

Up to now in the Digital Audio Generator config panel the combo box “Source Mode”

Source Mode | Audic Dala -
Jater Only

Ciomenon Ondy

was used to switch between Audio Data and Impairments (Jitter only or Common only).

From now on Audio Data and Impairments are generated simultaneously and the above
selection is replaced by the check box “Add Impairment” switching the impairments on or off in
the Digital Audio Instrument.

Generator Config H=

W

Remote control command: SOURce:IMPairment ON | OFF

The Impairments can be configured in the new instrument
Instrument |L'Hgia] imipair et ﬂ
Source Mode |thter :]

Ref Voltage -
Common
Ref Frequency |tEIIII 00 Hz

Remote control command: INSTrument[1][:SELect] IMPairment

This instrument is used to select the kind of impairment - jitter or a common mode signal - which
can be added to the output signal of the Digital Audio Generator. Impairment parameters are
then set in the Generator Function Panel in the same way as before.

New analyzer function “Rub&Buzz” (implemented in normal mode without polarity
measurement)
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Settling modes exponential, flat and average implemented for analyzer function, frequency and
phase measurement

Remote Control

When setting the GPIB address in the config panel the total UPV instrument state is saved
including the new address. Thus the UPV no longer “forgets” the new address when not shut
down but switched off.

Length of strings no longer restricted to 450 characters

Remote control commands for Printer configuration:
Source
HCOPy:SOURce WINDow | GRAPhics

Destination
HCOPy:DESTination PRINter | FILE | CLIPboard

Orientation (printer only)
HCOPYy:PRINter:ORlentation PORTrait | LANDscape

Store Mode (file only)
HCOPy:FILE:MODe NEW | OVERwrite | INCRement

Filename (store mode overwrite and increment only)
HCOPYy:FILE 'name'

Header/Footer (printer only)
HCOPy:PRINter:ADDition OFF | ON

Define Text of Header (printer only)
HCOPy:PRINter:HEADer 'text'

Define Text of Footer (printer only)
HCOPy:PRINter:FOOTer 'text'

Start Hardcopy
HCOPy[:IMMediate]
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Trace data can be sent to the UPV and are then displayed in the relevant Display Panel

TRACe:SWEep<i>:STORe:AX <Data>
TRACe:SWEep<i>:STORe:BX <Data>
TRACe:Subsys<i>:STORe:AY <Data>
TRACe:Subsys<i>:STORe:BY <Data>

Data are float numbers without units separated by comma: <bata> = n,n,n,n
Subsys = SWEep | BARgraph | FFT | WAVeform

X-axis data are allowed for Sweep Graph Display only. X-Source must be set to “Manual”
in the Sweep Graph Config Panel.

Remote control commands to scale graphics (in display config panels)

DISPlay:Subsys<i>:A|B:SPACing LINear | LOGarithmic
DISPlay:Subsys<i>:A|B:TOP <nu>
DISPlay:Subsys<i>:A|B:BOTTom <nu>
DISPlay:Subsys<i>:X:SCALing AUTo | MANual
DISPlay:Subsys<i>:X:SPACing LINear | LOGarithmic
DISPlay:Subsys<i>:X:LEFT <nu>
DISPlay:Subsys<i>:X:RIGHt <nu>

Subsys = SWEep | BARgraph | FFT | WAVeform

Remote control commands to set units (in display config panels)

DISPlay:Subsys<i>:A|B:UNIT:TRACk ON | OFF
DISPlay:Subsys<i>:A|B|X:UNIT <u>
DISPlay:Subsys<i>:A|B|X:UNIT:AUTo ON | OFF
DISPlay:Subsys<i>:A|B|X:UNIT:USER 'string'

Subsys = SWEep | BARgraph | FFT | WAVeform

Remote control commands to handle limit lines (in display config panels)

DISPlay:Subsys<i>:A|B:LIMUpper|LIMLower ON | OFF
DISPlay:Subsys<i>:A|B:LIMUpper|LIMLower:SOURce VALue | HOLD | FILE | IFILe
DISPlay:Subsys<i>:A|B:LIMUpper|LIMLower:SOURce:VALue <nu>
DISPlay:Subsys<i>:A|B:LIMUpper|LIMLower:SOURCce:FILE 'filename'

DISPlay: Subsys:TRACKk:LIMit ON | OFF

DISPlay:Subsys<i>:A|B:LIMShift ON | OFF
DISPlay:Subsys<i>:A|B:LIMShift:PARallel <nu>
DISPlay:Subsys<i>:A|B:LIMShift:SYMMetrical <nu>

Subsys = SWEep | BARgraph | FFT | WAVeform

Remote control commands to move cursors

DISPlay:Subsys<i>:OCURsor:SETTo:MAX | MIN | MRKA | MRKB
DISPlay:Subsys<i>:XCURsor:SETTo:MAX | MIN | MRKA | MRKB
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Subsys = SWEep | BARgraph | FFT | WAVeform

DISPlay:Subsys:OCURsor:SETTo:XPOS <nu>
DISPlay:Subsys:XCURsor:SETTo:XPOS <nu>

Subsys = SWEep | FFT | WAVeform

Remote control commands to move markers

DISPlay:Subsys<i>:A|B:MARKer:MODE OFF | FIXed | TRKMax
DISPlay:Subsys<i>:A|B:MARKer:HARMonics ON | OFF
DISPlay:Subsys<i>:A|B:MARKer:SETTo:OCURsor
DISPlay:Subsys<i>:A|B:MARKer:SETTo:XCURsor
DISPlay:Subsys<i>:A|B:MARKer:SETTo:XPOS <nu>

Subsys = SWEep | FFT | WAVeform

General

Setups with long FFTs or Waveforms are now loading much faster than before

Now it can be selected in the Config Panel if the COM Interface is used for Remote or Switcher
Control. A new selection is valid after reststart of UPV application.

Config Panel HBEE

Seriad Porl

Use Ser.Port | Swicher |

i Remote

Advantage: Use of COM Interface is no longer automatically switched to Remote Control, if UPV
application is started while Switcher operation is set to off in Switcher Control Panel.

Version 1.3.0

Analyzer/Generator

External analyzer sweep with fast frequency trigger and voltage trigger now implemented.
Selectabe via Start Conditions Freq Fast Ch1/2 and Volt Ch1/2. This feature can be used in
parallel with generator sweep.

New analyzer function: FFT based 1/n octave analysis. Selectivity can be set to 1, 1/3, 1/6, 1/12,
1/24 octave and to critical bands.

New Polarity Test Signal: Sine squared burst was replaced by two combined sinewaves.
Advantage: New signal needs less bandwidth and has no DC component. Frequency can be
selected.

Old signal: Sine squared burst New signal: Two combined sinewaves
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Digital analyzer: RMS selective now provides one additional Filter

Channel Status Data can now be displayed binary only (without text)

Prot Analysis FF  Show |

Display Mode [automatic ]
Hghignt  [Nothng  ¥]
Persistence  [Shot 7]
View Mode  [BraryseTedt =)

Binary+Text

Graphics

Noise density display available for FFT Graph1 and 2
Select Reference = Noise Density in the FFT Graph Config Panel

Reference IN::uise Density j

Unit Frct Track [ |er "I
Unit Auto r |w«sz

The level of each FFT bin is now rescaled to a bandwidth of 1 Hz, thus displaying the power
density. The unit is fixed to V/sqrt(Hz). Noise Density Calculation is available for Analog
Analyzer FFT Level only

HEX display for Digital Analyzer: Any level measurement result using the unit FS can now be
displayed in Hexadecimal format

| Fumction Con =loix
Channe 1 [ Numeric Display
Display Show]|
Link FS -
Wiewwr Hix [

Trace data can be stored filtered according to the selection made in the Data List.

1. Make the selection in the Data List:
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Lim upper Lirm lower Lim upp & low Harmonics

2. Store the selected data in the relevant Display Config Panel as *.trc file

Store Traces

b s

Store Trace ag | (8N g e

Auxiliaries Panel

The signal at the Anlg Aux Output (BNC connector at the rear panel) can be set to a DC Voltage
or can follow Channel 1 of the Signal Source selected for the Audio Monitor: Input, Function or
Generator. Up to now only Generator was possible.

Analog Aux Output |

g Aot | ENEEYERSTIN - |

Remote Control

Status reporting system now supports the following bits:
“Run executable” indicates that an executable file was started and is still running.

“Hardcopy in progress” indicates that a hardcopy was started and is not yet finished.
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Version 1.2.2

Analyzer/Generator

Digital Audio Protocol Analysis and Generation available, with option UPV-K21 installed

See below for remote control commands

Pretrigger implemented for Analyzer Functions Record and Waveform

Function Waveform: Measurement Modes Compressed and Undersample implemented

Generator Dwell Sweep can now be used with analyzer function Record: useful for recording
test signals swept over frequency and/or voltage with a fixed time step

Graphics

Graphic Displays can now be opened from the Analyzer Function Panel using the new ‘Show’
Buttons

™ Analyzer runction.___ R [= F
Blergraph I- Shorw _ﬂ
Post FFT ™ Show

Lavel Monloe |t -
mw ..PH* =1
FregiFhase Frequency -
Meaz Tme  (+ Fast ( Prec
Frag Sefting o -
;'Frm I M
wisvetorm [ Show |
.PrdAMH,ﬁs r o showl| =
General

File Selector can be switched from R&S style to Windows style

... open config panel ...

ml Rohde & Schwarz Audio Analyzer UPY Screen 1

File Edit Screenz Instrumentz DispConfig Dizplavs Sequence Hilties wWindows HeIpI

Diagnostic Panel (clozed)

|En:|nf|c| Fanel [closed)
Install Options. ..

... make the following selection

File Selector
Winstyle [

New Function ‘Execute Macro’ starts an executable file *.exe

Can be invoked via Menu -> Sequence -> Execute Macro -> file selector
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or via Diagnostic Panel -> Exec Macro -> direct entry of filename
GPIB command: SYSTem:PROGramm:EXECute ‘filename’

Remote Control

GPIB commands for Generator Function Play implemented

Bandwidth Play Auto OUTPut:BANDwidth:MODE AUTo

Function SOURce:FUNCtion PLAY

Shape File MMEMory:LOAD:ARBitrary 'filename'

Scale Pk to Fs SOURce:PLAY:SCALepktofs ON | OFF

Channel SOURce:PLAY:CHANnel MLEFt | MRIGht | STEReo

Play Mode SOURce:PLAY:MODE TOCont | TOSingle | TICont | TISingle
Time: SOURce:PLAY:TIME <nu>

GPIB commands for Protocol Data Generator

SOURce:PROTocol:MODE AUTomatic | PROFessional | CONSumer
SOURce:PROTocol:CRC ON | OFF

SOURCce:PROTocol:VALidity NONE | CH1ANnd2
SOURce:PROTocol:AZERo ONCE

Direct setting the value of a byte in a channel
SOURce:PROTocol:CH<x>:BYTE<y> <n>
<x> = Channel 1 or 2

<y>=Byte0...3

<n>=Value 0 ... 255

Numeric Byte entry :

SOURce:PROTocol:NUMerical:CH <n> , with <n>=1 or 2
SOURce:PROTocol:NUMerical:BYTe <n>, with <n>=0... 3
SOURce:PROTocol:NUMerical:VALue <n>, with <n>=10 ... 255

Track or Split Channels:
SOURce:PROTocol:CHANnels CH2Is1 | SPLit

GPIB commands for Protocol Data Analyzer
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Switch on/off Protocol Analysis function and display:
SENSe8:FUNCtion ON | OFF
SENSe8:PROTocol:DISPlay ON | OFF

Read out of Byte value:
SENSe8:PROTocol:CH<x>:BYTE<y>?
<x> = Channel 1 or 2
<y>=Byte0...4

Return value =0 ... 255

Select display mode:
SENSe8:PROTocol:MODE AUTomatic | CONSumer | PROFessional

Highlight changes:
SENSe8:PROTocol:HIGHIight NOTHing | FOUTput | BETWeen | FSTart
SENSe8:PROTocol:PERSistence SHORt | LONG | FORever

Version 1.2.1

Analyzer/Generator

Burst Signals (Sine Burst, Sine? Burst) now restarts whenever a new measurement is triggered.

Version 1.2.0

Analyzer/Generator

S/N sequence implemented for RMS, Peak and Quasi Peak measurements.

S/N can be selected as new measurement function, the detector (RMS, Peak or Quasi Peak) is
then selected as Meas Mode within the S/N function.

In addition S/N can be selected as “S/N sequence” within the selected measurement functions
RMS, Peak and Quasi Peak.

New high pass filter 22 Hz implemented, which is selected by default when invoking the S/N
measurement function

Waveform is now triggered

Group delay measurement implemented

Phase measurement format infinite phase implemented

New analyzer function Record to * WAV
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Analyzer Start Conditions Time Tick and Time Chart implemented

Analyzer function Polarity now implemented

Equalization for analyzer FFT and FFT-based measurement functions implemented.

FFT averaging modes exponential and normal implemented

Measurement speed improved for Distortion measurements at low frequencies

Measurement speed improved for RMS selective measurements at low frequencies

New generator function Play * WAV

New analog generator bandwidth “Play Auto”. This selection restricts the generator functions to
“Play” only. The sample rate the WAV file was recorded with is then used to clock the generator,
e.g. useful for files recorded with 44.1 kHz.

Generator DC offset voltage range extended to -10 V to + 10 V for balanced outputs

Equalization for generator signals implemented (UPL file format is still supported)

Generator sweep: Next step = Dwell Value implemented

Extended functions for 12S instrument: New format = “User Definable”

Generator Analyzer

Format U=zer Definable
Faync Shape ISquare Pulze j Format ser Definakble
Faync Polarity ILeft (17 = Low j Feync Slope ILeft 17 = Falling vI
wiord Offset |4 wiord Offset [

Graphics

Limit check now supports the use of limit files.

New feature Limit Shift:

Limit Upper v

Source I"-.f'alue j

!

20.0000 B

Limit Lowwer |7

El
o UPY S etup |

Limit Shitt ¥

Source

N

Patallel 5.00000 dBr

Swyimmetrical | 0.00000 dBr

i

Limit lines defined by value or file can be shifted in parallel or symmetrically along the Y-Axis.
This can be used to adjust the desired tolerance scheme loaded from limit files.

Trace files can now be stored as equalization files and as limit files, too.

Normalize now implemented for Reference = Gen Track and Reference = File. In case of
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Reference = Gen Track, graphics is updated during running sweep only. ‘

General

New Printer (H Copy) control

Config Panel A= ill
GPB Address
GPB Addrecs IED
Prirder -

Source ILIP’V Wind. (Bitma vl

Source: UPV window (screen) or active graphic window
Destination: Printer, File or Clipboard

Vector format available for printer only, *.EMF for file or clipboard not yet supported.

Control of Audio Monitor in Auxiliaries Panel modified:

| Auwories [« P
Auschio Mordor

Audio Monitor [

Speaker enable v

Phone enable v

Audio Monitor check box switches on/off, what is pre-selected in the two lines below. If speaker
or phone state is changed to enable, audio monitor is switched on automatically.

Adjustment routines which automatically calculate the correction factors for hardware options
UPV-B1, -B2 and -B3 now available.

Diagnostic Panel

Disgrostic IPass'Md? |
Adjustment

Low Dist (81) _Exec |

Sec. Gen(B3) _Exec |

Fileselector now able to position cursor with mouse. DEL key supported.

Hardware code, serial number and product index in board eeprom can be indicated and
changed via diagnostic panel (manual or remote operation). Access to full diagnostic panel is
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necessary (for service purposes only).

Remote Control

New command: “init:force stop” terminates a continuous measurement (“init:cont on”)

Scmln j" of 20

GPIB command for scan selection implemented
DISPlay:SWE-<i>:SCANoffset <n>

i=1,2,3,4

n =2 | MAXimum, 1 | MINimum , O to -19

DISPlay:FFT<i>:SCANOoffset <n>
i=1,2

n =2 | MAXimum, 1 | MINimum , O

DISPlay:MONitor:SCANoffset <n>
n =2 | MAXimum, 1 | MINimum , O to -19

DISPlay:WAVeform:SCANoffset 0
DISPlay:BARgraph<i>:SCANOoffset <n>
i=1,2

n =2 | MAXimum, 1 | MINimum , 0

Note: Query always returns numbers (MAX =2, MIN = 1)

Read back of Min or MAX traces now possible

Alias commands added:
TRACe:LOAD:SWE = TRACe:LOAD:SWP

GPIB commands for selection of Y-Source and Reference settings in display config
panels for all display subsystems implemented

------- Y-Source commands

DISPlay:SWE-<i>:A:YSOurce

DISPlay:SWE<i>:B:YSOurce

OFF | FUNC1 | FUNC2 | FREQ1 | FREQ2 | PHASe | GROupdelay | LMRM1 |
LMRM2 | LMDC1 | LMDC2 | LMPK1 | LMPK2 | INPP1 | INPP2 | FILEA | FILEB
<i>=1,2,3,4
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Version 2.3.0

DISPlay:FFT<i>:A:YSOurce
DISPlay:FFT<i>:B:YSOurce
OFF | FFTL1 | FFTL2 | FFTP1| FFTP2| FILEA | FILEB

<i>=1,2

DISPlay:MON:A:YSOurce
DISPlay:MON:B:YSOurce
OFF | LEV1 | LEV2 | PHAS1 | PHAS2 | FILEA | FILEB

DISPlay:WAV:A:YSOurce
DISPlay:WAV:B:YSOurce
OFF | LEV1| LEV2| FILEA| FILEB

DISPlay:BAR<i>:A:YSOurce
DISPlay:BAR<i>:B:YSOurce
OFF | FUNC1 | FUNC2 | FILEA| FILEB

<i>=1,2

____________ Reference commands

DISPlay:SWE-<i>:A:REFerence

DISPlay:SWE<i>:B:REFerence

DISPlay:FFT<i>:A:REFerence

DISPlay:FFT<i>:B:REFerence

DISPlay:BAR<i>:A:REFerence

DISPlay:BAR<i>:B:REFerence

MEASpanel | VALue | MAXimum | XCURsor | OCURsor | REF997 | REF1000 |
CH1Meas | CH2Meas | GENTrack | FILE | HOLD

<i> =1, 2, 3, 4 for Sweep

<i> =1, 2 for FFT and Bargraph

DISPlay:MON:A:REFerence

DISPlay:MON:B:REFerence

VALue | MAXimum | XCURsor | OCURsor | REF997 | REF1000 |
CH1Meas | CH2Meas | GENTrack | FILE | HOLD

DISPlay:WAV:A:REFerence VALue
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DISPlay:WAV:B:REFerence VALue

--------------- commands to set the reference value

DISPlay:SWE<i>:A:REFerence:Value <nu>
DISPlay:SWE<i>:B:REFerence:Value <nu>
DISPlay:FFT<i>:A:REFerence:Value <nu>
DISPlay:FFT<i>:B:REFerence:Value <nu>
DISPlay:MON:A:REFerence:Value <nu>
DISPlay:MON:B:REFerence:Value <nu>
DISPlay:WAV:A:REFerence:Value <nu>
DISPlay:WAV:B:REFerence:Value <nu>
DISPlay:BAR<i>:A:REFerence:Value <nu>
DISPlay:BAR<i>:B:REFerence:Value <nu>
<i> =1, 2, 3, 4 for Sweep

<i> =1, 2 for FFT and Bargraph

Remote operation no longer displays any message boxes

GPIB commands for Waveform monitor added:

SENSe7:FUNCtion ON | OFF

SENSe7:MMODe STANdard | COMPressed (compressed not yet implemented)
SENSe7:COMPfact <n> (compressed not yet implemented)

SENSe7:INTerpol N1 | N 2| N4 | N 8| N16 | N32 (interpolation not yet implemented)
SENSe7:TRCLength <nu>

SENSe7:TRIGger:SOURce CH1 | CH2 | MANual

SENSe7:TRIGger:LEVel <nu>

SENSe7:TRIGger:SLOPe RISing | FALLing

SENSe7:TRIGger:PRE <nu> (pretrigger not yet implemented)
SENSe7:TRIGger:AUTo ON | OFF

Version 1.1.0

Analyzer/Generator

DFD and ModDist signal generation and analysis implemented in analog and digital domain.

DIM signal generation and analysis in analog domain only, with UPV-B3 installed.

RMS selective, Peak and Q-Peak measurements implemented
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Jitter and Interface Test available, with option UPV-K22 installed

Sample rate measurement implemented

THD+N wide filter now available

Multisine with up to 32 spectral lines

Random signal generation in frequency and time domain

Arbitrary waveform generation

Phase sweep for stereo sine

General
R&S UPZ Switcher Control implemented:
Connect UPZ to COM port of UPV, then open Switcher Panel .....

m Rohde & Schwarz Audio Analyzer UPY Sore =|E|-| -5!
Fie Edt Screens | Instruments Displonfig Displz Swwibcher

Geriersbor Function Tracking F‘F"—'_T_l
inhezer Contig ﬁ—
Analyzer Furction il

Fikar {closad) rocnxE) o

furriisries (closed) Cugt Chl (&) I'-"

>

Functions are identical to UPL, see UPZ operating manual

Help system implemented (English version only)

New file selector for Save/Load accepts alphanumeric entry from frontpanel keys

Option UPV-K1 (Automatic Sequence Controller) now supported

Audio Monitor: Signal Source extended to Function and Generator

Audio Monitor: Speaker and Phone Out can be activated separately. Plug in of Headphone Jack
does not mute the speaker.

Multiscans implemented

Start UPV with preset: Press front panel PRESET key, when UPV start screen appears

Menu bar and/or tool bar can be switched to permanent view

... open config panel ...

ml Rohde & Schwarz Audio Analyzer UPY Screen 1

File Edit Screenz Instrumentz DispConfig Dizplavs Sequence Hilties wWindows HeIpI

Diagnostic Panel (clozed)

|En:|nf|c| Fanel [closed)
Install Options. ..

... make the following selections ...
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Version 2.3.0

| Config Pae =10l xf
GPIE Address

GPB Address I.?Ji
Abways visibie

e Bar [~

Tool Bar =

...and you get ...

ml Rohde & Schwarz Audio Analyzer UPY Screen 1

File Edit Screens Instruments DispConfig Displays Sequence  Ukilikies  Windows Help

I

SHEH

[7][2][3] [4] [5]

Remote Control

key SHUTDOWN.

New command “SYSTem:SHUtdown” shuts down the instrument. Same function as front panel

New commands to read back trace data, see below

UPV read back trace data
The UPV has 10 graphic subsystems:

4 Sweep graphs

1 FFT monitor graph (not yet implemented)

2 FFT graphs
1 Waveform graph
2 Bargraphs

In each of them you can read back the values of X axis and Y axis of trace A and B.

Graphic subsystem

Command to read back

Comment

Sweep graph <i>

TRACe:LOAD<i>:SWP_AX?

Trace A, X axis

(i=1,2,3,4) TRACe:LOAD<i>:SWP_AY? Trace A, Y axis
TRACe:LOAD<i>:SWP_BX? Trace B, X axis
TRACe:LOAD<i>:SWP _BY? Trace B, Y axis
FFT Monitor TRACe:LOAD:MON_AX? Trace A, X axis

TRACe:LOAD:MON_AY?
TRACe:LOAD:MON_BX?
TRACe:LOAD:MON_BY?

Trace A, Y axis
Trace B, X axis
Trace B, Y axis

FFT graph <i>
(i=1,2)

TRACe:LOAD<i>:FFT_AX?
TRACe:LOAD<i>:FFT_AY?
TRACe:LOAD<i>:FFT_BX?
TRACe:LOAD<i>:FFT_BY?

Trace A, X axis
Trace A, Y axis
Trace B, X axis
Trace B, Y axis

Waveform graph

TRACe:LOAD:WAV_AX?
TRACe:LOAD:WAV_AY?
TRACe:LOAD:WAV_BX?
TRACe:LOAD:WAV_BY?

Trace A, X axis
Trace A, Y axis
Trace B, X axis
Trace B, Y axis

Bargraph <i>
(i=1,2)

TRACe:LOAD<i>:BAR_AX?
TRACe:LOAD<i>:BAR_AY?
TRACe:LOAD<i>:BAR_BX?
TRACe:LOAD<i>:BAR_BY?

Trace A, X axis
Trace A, Y axis
Trace B, X axis
Trace B, Y axis
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4 Fixed Bugs

Version 2.3.0

Analog Analyzer Bandwidth 250 kHz: Sometimes FFT-based measurements using FFT sizes
longer than 128 k did not terminate. Now fixed.

Trigger Output: Mode = Aux Clock Out: Due to hardware restrictions the minimum frequency is
limited to 100 Hz. Up to now frequencies down to 0.1 Hz could be set in the panel. Now fixed.

Multiscan Sweep: Sometimes after re-start of the sweep (Button START) the previous curves
were not deleted correctly. Improved.

PESQ: Depending on length and sample rate of the speech file, the UPV might crash if Trace A
was set to “Deg Signal” and Trace B was set to “Ref Signal” in the PESQ graphic config panel.
Now fixed.

If an interchannel delay was used in the FFT function, this delay was still used when switching to
a different measuring function. Now OK.

The frontpanel key +/- didn’'t work if the external keyboard was set to german. Now fixed.

Delay measurement in conjunction with Gen Track mode no longer switching channels after
timeout of more than 5 sec.

Improvements with triggered waveform display: sometimes untriggered display or incomplete
curve were shown

RMS Selective Measurement in conjunctionw with "Gen Track" measurement mode could result
in wrong function result due to setting problems with the internal notch filter

If a file (setup or traces) is saved to a storage medium having not enough free disc space, an
error message now indicates that no file can be stored.

Remote Control: Improved indication of error codes

An analyzer time tick sweep could freeze due to user interaction in the windows operating system
(e.g. copy and paste of files or folders) while UPV application is minimized, or in rare cases even
without user interaction. Now OK.

Remote Control: The command TRACe:Subsystem<i>:STORe:AX|AY|BX|BY <n,n,n,n> is used
to transfer trace data to a graphic subsystem (SWEep, FFT, WAVeform, BARgraph, PESQ).
<n,n,n,n> can now be ascii or binary data. Up to now no binary data transfer was possible.

If a measurement function was selected in the analyzer function panel, a combi display could pop
up if it was already open in a different screen.

Function Config Panel: The measured value of channel 2 could not be stored as a reference
value, because “Reference Store Ch2” did not update the reference value.

Referance Wil it

Walue
1 Store Chl

sto o EETTETN

b ©ind

Now the actual measured value is stored as the new reference value.

Remote Control: For all measurement results the command SENSe<a>:DATA<b>? did not

return the correct value, if a relative unit with reference set to Meas Ch1 or Meas Ch2 was
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selected, because the static reference value previously stored via Value, Store Ch1 or Store

Ch2 was used, instead of the actual measured value.

Reference e -
Yalue
Store Chi

Ao Scale Store Ch2

Sy (TR
Maas Ch2

Right Gen Track

Now the actual measured value of channel 1 or 2 is used as reference value.

LSB units allow negative value input now

Missing clock on B2 / B20 input now produces hint in status line

PESQ measurement in CONT mode no longer losing data

Changing PESQ “According to” or graphics source no longer triggering new measurement

PRESET value for dual channel analog analyzer impedance was 600 Ohm in firmware version
2.2.0.311Beta, is now 200 kOhm, as it was before.

Distortion measurements: Precision Mode did not work correctly in firmware version
2.2.0.311Beta, now OK again.

THD, THD+N: In single channel mode (input channel 1 or 2) fundamental signal was filtered by
function filter, now fundamental signal is not filtered (as it is in two channel mode).

Changing the unit of x axis in sweep graph panels now only on following conditions: changing
sweep settings / changing the start condition / changing the desired generator unit / changing the
physical sweep unit

Waveform trigger level now supporting additional units like “dBr”
Possible deadlock with high CPU load fixed

Version 2.1.1

Malfunction when entering a function reference value for channel 2:

The value entered for channel 2 did not effect channel 2 but channel 1 result. Channel 2 always
referred to 1.0.

Version 2.1.0

Analyzer function Record: Level trigger now works properly independent from Waveform
function being switched on or off.

Level monitor peak displayed a wrong result, if frequency measurement was switched off.

Analyzer function RMS Selective: Freq Mode Auto Both: Measurement result was set to invalid
(---) on both channels, if one channel had no signal. Now both channels measure independently.

In bargraph display limit check did not work properly, if limit shift was used. Now fixed.
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Improved handling of limit files, which could not be loaded.

Improved indication of execution errors during remote control.

Version 2.0.0

Signal to Noise measurement:

After a Single Sweep had terminated, S/N measurement continued at the start frequency of the
sweep. Now S/N measurement is stopped at the end of the sweep.

Single channel sweep did not start, if settling was activated.

Phase measurement: If a frequency could not be measured (e.g. due to low signal level), or if
frequencies are different in both channels, phase measurement result is marked as invalid (---).
Up to now a (meaningless) phase result was displayed.

RMS selective measurement: With Bandwidth set to “BP 1/3 Oct Fast” and Frequency mode set
to “Gen Track” a change in frequency at low frequencies could produce a wrong first reading.
Now correct result, due to slightly increased internal settling time.

Generator function Play: No output signal, if analog generator is used and only channel 2 is
switched on. Now correct output signal.

A-weighting filter was overdriven, when used in analog analyzer with 250 kHz bandwidth. Now
correct function, due to increased internal headroom.

Measurement was stopped when a setting was made in the Switcher Panel. Now measurement
continues.

Remote control command “HCOPy[:IMMediate]” did not work. Now correct function.

The Error Bit (ERRQ) in the Status Byte (STB) was only set due to Syntax Errors. Now also
Execution Error and Device Dependent Error set the Error Bit.

Switching from REMOTE to LOCAL now automatically updates numeric measurement values
and graphic displays

ok

During remote control measurement was stopped when the command “*rst” was sent. Now

measurement continues.

Config Panels for Function, Input, Level Monitor and Freg/Phase: The entry fields “Left” and
“Right” for bargraph scaling are interchanged. Now “Right” is on top of “Left”, because “Left”
depends on the setting of “Right”.

Frwter Though Store Mode Overwrite was selected, the UPV asked
e gy i before storing the file. Now the file is stored (overwritten)
i Jupvwind. Btm =] ot further request.

Destirsfion File -

Store hMode i(‘lvfrwr:e -
Fllerarme c: est bimp _l

In some cases, though set to Auto mode, a wrong Label or Unit
might be displayed. Now fixed.
Un Ao Y

Handling of Limit Files in Display Config Panels was improved due to several bugfixes.

Limit lines: Valid range for the value of limit lines was limited to the range between top and
bottom of the graphic display. Now the value for the limit lines does no longer depend on the
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settings of top and bottom.

Limitfiles, having a unit with a A (delta) character, could not be loaded. Now correct.

Version 1.4.0

When changing the generator instrument or loading a setup while the UPV is in “Output Off”
state, the generator state bits 10 to 12 in questionable register did not indicate the correct state.

Jitter weighting filter: 3 dB cut-off frequency changed from 200 Hz to 700 Hz

Problems with UPV-K1 operation fixed:

- Firmware crash if restarting external EXE immediately after last execution

- Reading empty strings under some circumstances, mostly after reading binary data

Problems with UPV-K4 operation fixed:
- Time consuming setting commands even if setting is not changed

- Firmware crash after long time of operation in conjunction with loading setups

Analyzer start condition Time Tick: Time intervall was longer than set in the panel, now correct.

Time Tick/Chart: Though not valid and not indicated in the Panel, a delay selected before was
still used. Now delay = 0 is used.

RMS selective measurement did not start during Generator sweep when Analyzer Frequency
Mode was set to Generator Track -> Fixed

Reference set to o-cursor or x-cursor did not work correctly -> Fixed

Equalization file was ignored in generator function Burst -> Fixed

Noise density measurement: Now correct results for every window, not only for rectangular.

Sometimes during remote control correct commands were rejected -> Fixed

Version 1.3.0

In continuous measurement mode (init:cont on) the 0 to 1 transition of the OPC-Bit, which can
be used to generate an SRQ, now comes after the first valid measurement value. Up to now the
OPC-Bit was not supported in this mode, because a continuous measurement was treated as an
operation that is never completed.

For remote control it is recommended to generally use the single measurement mode (init:cont
off), which returns settled measurement values.

When sending more than one remote command in one control program line, and mixing
common commands with UPV specific commands, in an unpredictable way some of the
commands might be ignored. -> Fixed
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Status reporting system: Execution Error Bit now supported.

During single measurement the autoranger might not terminate due to some strange input
signals -> Fixed

In THD+N measurement, using Meas mode Noise, the result was dependent on the size of the
FFT ->Fixed

In the display config panels the state of

Label Auto

Unit Fnct Track

Unit Auto
was not stored in a setup file -> Fixed
When switching to measurement functions Mod Dist or DFD from any other measurement
function having a filter switched on, this filter was not switched off -> Fixed
Signal to Noise Measurement with a filter switched on: Though the filter is bypassed during
signal measurement, the internal filter gain was still active, resulting in too good measurement
values -> Fixed
Waveform Mode Compressed: Measurement time was multiplied by compression factor,
resulting in unnecessary long times. -> Fixed
If the Help or Fileselector window is minimized (only possible if the UPV is operated by mouse)
the UPV application seems to freeze. That's why the minimized window still has the focus but is
not accessable via front panel keys (only via alt+tab using an external keyboard). -> Fixed
Now the Help or Fileselector window can no longer be minimized.
An Equalization file having 256, 512, 768 or 1024 points loaded in Generator or Analyzer was
ignored -> Fixed
Display Config Panel: Though tracking was checked, the normalize settings were not tracked
from trace A to trace B

Refarsnce IGen Track 'I [ IlI-lr:'u Track d
Mormalize I\;aue - I Ix_.a - j
I:‘ Q0000 L I: Q0000 U

-> Fixed

Version 1.2.2

Bugfix of hang-ups after very long time of remote control -> Fixed

¢ Redesign of measurement handshake host / DSP to avoid unrequested Upload
messages caused by autoranger activity. Although these messages had been ignored
by host it might cause communication hang-ups ("No response from DSP B1...") if more
than 1 autoranger message was sent before end of measurement was acknowledged
by host.

e Bugfix of DSP A1 crash caused by autoranger activity if signal level was raised just
before end of measurement.

Bugfixes RMS selective:

e Bandpass "1/3 octave fast": SINGLE key stroke resets filter delay lines and starts
measurement without resetting filter.

e Auto Measurement ("Freq Mode Freq Ch1/2") did not terminate if no signal provided
(instable frequency measurement)

Autoranger improved:
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During long measurements (e.g. RMS selective-measurement using sharp selection filters)
peaks with repetion rates below 5 Hz might cause never terminating measurement due to infinite
up and down ranging. -> Fixed

Read back trace data via remote control returns traces that use Reference Value set in Meas
Panel instead of Reference Value set in Display Config Panel. Workaround: Track Display Panel
Reference to Meas Panel and set the Reference Value in Meas Config Panel. -> Fixed

Generator Function Play: ‘OUTPUT OFF’ key didn’t switch on the switched-off signal. -> Fixed

Analyzer Config Panel: Switching Channels to 1=2 didn’t track a fixed range from Cannel 2 to
Channel 1. -> Fixed

Version 1.2.1

Waveform trigger level: wrong units and limit values when changing analyzer instrument. ->
Fixed

Remote control: Problems when frequently sending GTL commands. -> Fixed

Remote control: SRQ now correctly generated on OPC.

Sometimes in an unpredictable and not reproducable manner after many hours of remote
operation the UPV application terminates. A message box "...memory could not be read" may
occur. -> Fixed

Normalize of curves: In case of Reference = Gen Track, graphics is updated during running
sweep only. -> Fixed

Version 1.2.0

Frequency response of user defined *.npz filters is now independent of sample rate

Weighting filters having gain > 1 no longer clip at Fullscale

When UPV is powered on, the SW performs an internal DC offset measurement, which fails, if
the DC voltage is already present at the inputs during power on. This in turn produces an
erroneous DC voltage reading. -> Fixed

FFT or Waveform traces longer than 32 k points could not be stored. -> Fixed

Output OFF key or any user settings in Auxiliaries or Filter Panel start a terminated
measurement or a waiting sweep. -> Fixed

Arbitrary function: Not the maximum value in the file but the value 1.00 was scaled to the peak
value as set in the generator function panel, resulting in erroneous level settings. -> Fixed

Generator overload was not indicated (by LED and status Gen overload) as long as no
measurement was running (Analyzer terminated), nevertheless the hardware was switched of
anyway. -> Fixed

Version 1.1.0
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Don’t use sample rates > 96 kHz for digital instruments. If > 96 kHz is necessary, change
sample rate in analyzer config panel first. -> Fixed

Digital audio generator: Phase to Ref setting terminates application. -> Fixed

5 Known Bugs

When closing the UPV application using Menu -> File -> Exit, the UPV will not close down
properly, but will show an error message or crash.

To correctly close the UPV application it is recommended to click to the close button El on the
title bar of the application.

The use of the old UPL remote control commands
"SENSe:VOLTage:RANGe[1] | 2.LOWer <nu>"
and
"SENSe:VOLTage:RANGe[1] | 2[:UPPer] <nu>"

can force an error message "Data out of range”

Instead of using the old UPL command
"SENSe:VOLTage:RANGe[1] | 2:.LOWer <nu>"

it is recommended to use the UPV commands
"SENSe:VOLTage:RANGe[1] | 2:MODE LOWer" followed by
"SENSe:VOLTage:RANGe[1] | 2:VALue <nu>"

Instead of using the old UPL command
"SENSe:VOLTage:RANGe[1] | 2[:UPPer] <nu>"

it is recommended to use the UPV commands
"SENSe:VOLTage:RANGe[1] | 2:2MODE FlIXed" followed by
"SENSe:VOLTage:RANGe[1] | 2:VALue <nu>"

If one or both of the old UPL remote control commands
"SOURce:SWEep:MODE AUTO"
and

"SOURce:FREQuency | VOLTage | ONTime | INTerval:MODE CW | FIXed | SWEep1 |
SWEep2 | LIST1 | LIST2"

are used for sweep setting, an error message "Data out of range" will be forced.

Instead of using the old UPL command(s) it is recommended to use the UPV commands
"SOURce:SWEep:CONTrol OFF | ASWeep | ALISt"
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“SOURce:SWEep:XAXis | ZAXis FREQuency | VOLTage | ONTime | INTervall

6 Side Effects

Version 2.3.0

Frequency/Phase Config Panel: Up to now for frequency channel 1/2 and sample frequency
different settings were possible. From now on common settings for both channels and sample

frequency.

Freq / Phase Config ! E] E

Frequency
Osplay  Show]
Ui Hz o
Ao o [im
o

Resoiution Sdig FO.00MAE

Version 2.1.1/2.1.0/2.0.0

None

Version 1.4.0

In rare cases, firmware installation after reboot fails. Please try again installing the firmware.

Version 1.3.0

After changing the number of points of a generator sweep, the new sweep must be started with
the start key. Otherwise, depending on the direction of the sweep, wrong or incomplete data are
displayed.

In rare cases, firmware installation after reboot fails. Please try again installing the firmware.

Front panel keys WINBAR and MODIFY are not working properly, when menu bar is set to
permanent view. In this case the UPV is probably operated by mouse, and then those keys are
not needed, because mouse operation is more comfortable.
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Version 1.2.2

Waveform Measurement Mode Compressed is selectable, though not yet implemented. -
> Fixed Compressed Mode is now implemented

Softkeys Trace Show A or Show B don’t work properly if traces loaded from file are displayed
-> Fixed

In rare cases, firmware installation after reboot fails. Please try again installing the firmware.

Front panel keys WINBAR and MODIFY are not working properly, when menu bar is set to
permanent view. In this case the UPV is probably operated by mouse, and then those keys are
not needed, because mouse operation is more comfortable.

Version 1.2.0

SCPI recording: Commands which do not select a state but an action are not recorded correctly.
The state after the action is recorded, not the action itself. -> Fixed

It is not recommended to install a UPV simulation on a PC. Installshield does not finish properly
and firmware cannot be removed afterwards. -> Fixed

Front panel keys WINBAR and MODIFY are not working properly, when menu bar is set to
permanent view. In this case the UPV is probably operated by mouse, and then those keys are
not needed, because mouse operation is more comfortable.

Waveform Measurement Mode Compressed is selectable, though not yet implemented.

Softkeys Trace Show A or Show B don’t work properly if traces loaded from file are displayed

In rare cases, firmware installation after reboot fails. Please try again installing the firmware.

Version 1.1.0

Front panel keys WINBAR and MODIFY are not working properly, when menu bar is set to
permanent view. In this case the UPV is probably operated by mouse, and then those keys are
not needed, because mouse operation is more comfortable.

SCPI recording: Commands which do not select a state but an action are not recorded correctly.
The state after the action is recorded, not the action itself.

It is not recommended to install a UPV simulation on a PC. Installshield does not finish properly
and firmware cannot removed afterwards.

7 Hotline

If you have any questions or suggestions, please contact our hotline:
Telephone: +49 (0)180 512 42 42
Fax: +49 89 4129137 77
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E-mail: CustomerSupport@rohde-schwarz.com
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